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INSTITUTE VISION AND MISSION  

 

   

 

VISION: 

To emerge as a Center of Excellence for Learning and Research in the domains of engineering, 

computing and management. 

MISSION: 

IM1: Provide congenial academic ambience with state-of-art resources for learning and research. 

IM2: Ignite the students to acquire self-reliance in the latest technologies. 

IM3: Unleash and encourage the innate potential and creativity of students. 

IM4: Inculcate confidence to face and experience new challenges. 

IM5: Foster enterprising spirit among students. 

IM6: Work collaboratively with Technical Institutes / Universities / Industries of National, 

International repute. 

 

 

 

DEPARTMENT OF MANAGEMENT STUDIES VISION AND MISSION 

 

VISION 

Become Center of Excellence for Educating Management Students as Leaders of Tomorrow. 

MISSION 

 Provide congenial academic ambience with necessary infrastructure and learning 

resources. 

 Inculcate confidence to face and experience new challenges from industry and society. 

 Ignite the students to acquire self-reliance in State-of-the-Art Technologies. 

 Foster Enterprising spirit among students. 
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Program Educational Objectives (PEOs) 

PEO1: Have in-depth knowledge through life-long learning to conceptualize, critically analyze 

and add value in the areas of business management. 

PEO2:Have lateral thinking enabling simple solutions for complex managerial  problems. 

PEO3: Ignite the passion for entrepreneurship. 

PEO4: Inculcate a spirit of ethical and social commitment in the personal and professional life 

and to add value to the society. 

PROGRAM OUTCOMES 

PO1:   Apply Knowledge of management theories and practices to solve business 

 problems. 

PO2:  Foster analytical and critical thinking abilities for data - based decision 

 making. 

PO3:  Ability to develop value based leadership ability. 

                  PO4:          Ability to understand, analyze and communicate global, economic, legal and ethical         

aspects of business. 

                  PO5:  Ability to lead themselves and others in the achievement of organizational  goals, 

contributing effectively to a team environment. 

PO6:   Apply specialized tools and techniques of human resource management in real life         

business practices. 

                  PO7:  Apply the ever evolving marketing techniques to encounter the challenges and leverage 

opportunities. 

              PO8:   . Apply sophisticated financial tools and techniques for smooth management of     

organization. 

 PROGRAM SPECIFIC OUTCOMES (PSOs): 

On successful completion of the program, the post graduates will be able to  

PSO1: Apply core and functionary management skills for professional growth and business           

evaluation. 

 

PSO2:  Adapt to dynamic changes in an environment relevant to professional managerial 

practice and entrepreneurship as emerging leaders. 
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I MBA – Semester - I 
Course Code 

DATA ANALYTICS USING ADVANCED 

EXCEL 

L T P C 
22MBA118 - 0 2 1 

 Course Educational Objectives (CEO): 

CEO1: To enable students understands the basics of spread sheet. 

CEO2: To enhance the knowledge in usage of Excel  

CEO3: To provide knowledge in advanced excel 

CEO4: To enable students to apply excel in different management areas 

CEO5: To make students use excel for research purpose. 

UNIT - I INTRODUCTION  TO  EXCEL Lecture Hrs: 10 

Cells – name range – references – Creating and editing worksheets-Cell Formatting-Creating 
and using formulas and functions-Use of Macros –Sorting and querying data- usage of Paste 
special 

UNIT - II APPLICATIONS OF EXCEL IN DIFFERENT 
AREAS 

Lecture Hrs: 6 

Preparation of a table Using EXCEL e.g. Employees payroll, Sales data, Students marks and 

perform the functions (Total, Average, Percentage, conditional sum and show the results in 

chart)-  Creating formulas for financial solutions. 

UNIT - III ADVANCED EXCEL Lecture Hrs::12 

Cell Referencing - Data Validation- Naming a Cell or Range of Cells (Name Manager).- Basic 

formulas (SUM, COUNTA, AVERAGE, MAX, MIN). Text Functions (RIGHT, LEFT, MID, 

SUBSTITUTE, FIND, LEN). Date Functions (TODAY, NOW, DAY, MONTH, YEAR, 

EDATE, EOMONTH, TEXT). 

UNIT - IV ADVANCED EXCEL II  Lecture Hrs::12 

Lookup Functions (VLOOKUP, HLOOKUP, MATCH, INDEX). - Logical Functions 
(IF, AND, OR). -Data Analysis Functions (SUMIF, SUMIFS, COUNTIF, COUNTIFS) - 
Conditional Formatting, Filtering and Sorting. - Graphs, Charts and Pivot Tables 
remove duplicates 

UNIT - V  CONDUCTING ONLINE SURVEYS Lecture Hrs:10 

Usage of Google drive – micro soft online surveys – sharing with the help of social media/ 
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internet- getting responses from online survey- sorting and filter online survey 

Course Outcomes: 

On successful completion of the course the student will be able 
to, 

POs & PSOs 
related to COs 

CO1 Explain basic concepts of Excel and create/edit spreadsheet  PO2, 
PSO1 

CO2 Apply basic excel formula in various functional areas of 
management. 

PO1, 
PSO1 

CO3 Demonstrate knowledge in using advanced excel functions PO2, 
PSO1 

CO4 Apply logical functions  of Excel  PO2, 
PSO1 

CO5 Use online methods to conduct surveys. PO4, 
PSO2 

 

 Text Books: 

1. Beskeen, D, Microsoft Office 2013: Illustrated introductory, first course. 
Stamford,    CT: Cengage Learning, 2013. 

2. Rinkoo Jainn, A to Z of MS EXCEL, A Book for Learners and Trainers, Amazon 
Digital Services LLC - KDP Print US. 2021. 

Reference Books: 

1. Introduction to Computers and Communications, Peter Norton-Sixth 
Edition-Tata McGraw Hill, 2009. 

2. V.Rajaraman, Introduction to Information Technology, Prentice Hall India, 2008 
3. Winston-Microsoft Office Excel Data Analysis and Business Modeling, First 

Edition, Prentice Hall India. 2007 
4. David Whigham, Business Data Analysis Using Excel, Oxford University Press, 

first Indian Edition. 

Online Learning Resources: 

https://support.microsoft.com/en-us/office/excel-video-training-9bc05390-e94c-46af-a5b3-
d7c22f6990bb 

https://trumpexcel.com/learn-excel/ 
https://digital.com/excel-tutorials/ 
 
 

 

 

 
 

https://www.google.co.in/search?sca_esv=556268279&hl=en&q=inauthor:%22Rinkoo+Jainn%22&tbm=bks
https://www.google.co.in/search?hl=en&q=inpublisher:%22Amazon+Digital+Services+LLC+-+KDP+Print+US%22&tbm=bks&sa=X&ved=2ahUKEwioyrzE9NaAAxUQxTgGHd4uB_gQmxMoAHoECBoQAg
https://www.google.co.in/search?hl=en&q=inpublisher:%22Amazon+Digital+Services+LLC+-+KDP+Print+US%22&tbm=bks&sa=X&ved=2ahUKEwioyrzE9NaAAxUQxTgGHd4uB_gQmxMoAHoECBoQAg
https://support.microsoft.com/en-us/office/excel-video-training-9bc05390-e94c-46af-a5b3-d7c22f6990bb
https://support.microsoft.com/en-us/office/excel-video-training-9bc05390-e94c-46af-a5b3-d7c22f6990bb
https://trumpexcel.com/learn-excel/
https://digital.com/excel-tutorials/
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COURSE OUTCOMES VS POs MAPPING (DETAILED; HIGH:3; MEDIUM:2; LOW:1): 
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C1108.1 - 3 -   - - - - 3  

C1108.2 3 - - - - - - - 3 - 

C1108.3 - 3 - - - - - - 3 - 

C1108.4 - 3 - - - - - - 3 - 

C1108.5 - - - 3 - - - - - 3 

C1108 3 3 - 3 - - - - 3 3 

 

 

 

 

 

 

 

 

 

 

 

 



SREENIVASA INSTITUTE of TECHNOLOGY AND MANAGEMENT STUDIES 

(Autonomous) 

CHITTOOR-517 127 

DEPARTMENT OF MANAGEMENT STUDIES 

DATA ANALYTICS USING ADVANCED EXCEL LAB MANUAL 
 

TABLE 1: RUBRICS FOR DAET LAB 

 Excellent(3) Good(2) Fair(1) 

Assemble 

(CO1) 

Student successfully completes 

the experiment, analyzes the 

experiment's main topics, and 

explains the experiment 

concisely and well. 

Student successfully 

completes the 

experiment and analyzes 

the experiment's main 

topics. 

Student successfully 

completes the 

experiment, and unable 

to analyze. 

 

Exhibit 

(CO2) 

Thorough analysis of excel 

models. 

Reasonable analysis of 

models. 

Improper analysis of 

models. 

Apply 

(CO3) 

Student understands excel 

models and formula,  and apply 

it  

Reasonable analysis of 

excel models and 

formula,  and apply 

Improper analysis of 

excel models and   

formula,    

Develop 

(CO4) 

Excellent knowledge in 

describing the data, and  develop   

templates 

Reasonable knowledge 

in describing the data, 

and develop   templates. 

Improper knowledge in 

describing the data, and 

develop   templates 

Derive 

(CO5) 

Excellent knowledge in 

extending the data analytics 

techniques for business purpose   

Reasonable knowledge 

in extending the data 

analytics techniques for 

business purpose   

Minimal knowledge in 

extending the data 

analytics techniques for 

business purpose   
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22MBA118  DATA ANAYTICS USING ADVANCED EXCEL    

LIST OF EXPERIMENTS 

 

 

 

 

 

 

 

 

 

S.No Experiment Name 

1 Create and Editing Worksheets by using Excel 

2 Creating Excel Sheets with Formula and Functions 

3 Create and Save Macros 

4  Sorting and  Querying Data 

5 Calculation of Ratios using Excel 

6  Preparation of Sales Transaction Report Using Excel 

7 Monthly Expenses Report using Excel 

8 Calculation of Ratios using Excel -2 

9 Using basic functions in Excel – Average, Count, Minimum , Maximum 

10 Application of  Date Function in Ms Excel 

11 Use of Sum, Sumif, Count and Count if functions 

12 Extracting Data using combined Vlookup and H lookup 

13 Consumer Satisfaction Survey Using Google Forms 
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Activity 1 

Creating, Editing worksheet using Excel 

Aim    To create and edit worksheets and perform self formatting 

Procedure  

Step 1 open Ms Excel 2007 

Step 2: Select the file tab and press new option to create anew book 

Step 3 Right click the sheet name and select insert option, click to add new hseet 

Step 4: Create more blank sheets using Shit + F11 Key in the key board 

Step 5  : Create the following rows and columns in the work sheet 

XYZ Ltd., 

Customer data base 

s.no Name city DOB Mobile No E-mail id 

1 John Newyork 12/12/2000   

2 Smith Losangeles 27/01/1991   

3 Jones Tokyo 31/03/1995   

4 David Moscow 15/04//1980   

5 Stephen Newyork 20/08/1990   

 

Step 6  Use different Font Types, Font Size from font group. Merge the cells to create heading 

Step 7 Format the cells as tet, umber and data 

Step 8 : Use bold, italic, , colors commands for the heading. Use underline for third customer 

(text editing) 

Step 9 : Click the first colum, press the right button to insert a new column to the right. Add new 

heading customer and enter the values 

Step 10 Add two more rows to insert new customers 

Step 11  Use borders for the talbe 
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Step 12 Save the work book by using Ctrl +S and save as dialog box opern. Save the file as 

Customer Data Base . press Ok 

What is a Worksheet in Excel? 

An Excel worksheet is the single sheet used in Excel documents, which contains groups 

of cells organized in rows and columns. Each worksheet allows users to record or write 

data within the cells as well as perform various operations with the recorded data. 

The worksheets are located in the bottom area of the Excel window, which is known as 

the Sheet tab. The new workbook has the following sheets by default: 

Backward Skip 10sPlay VideoForward Skip 10s 

 

We have three worksheets in the Sheet tab in the above image, such as Shhet1, Sheet2, 

and Sheet3. To view any of the desired worksheets, we need to click on the name of that 

particular sheet from the Sheet tab. 

How to create/ insert a worksheet in Excel? 
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In Excel, we have multiple ways to perform the most common tasks. Likewise, when it 

comes to creating a worksheet, we can use different methods, such as: 

o Creating a worksheet using the Sheet tab 

o Creating a worksheet using the Contextual Menu 

o Creating a worksheet using the Ribbon 

o Creating a worksheet using the Keyboard Shortcuts 

o Creating a worksheet using VBA 

Let us discuss each method in detail: 

Creating a worksheet using the Sheet tab 

The easiest method to create a worksheet within the workbook is to use the Sheet tab. 

Excel displays an additional Plus icon in the Sheet tab, called the 'Add/Insert Worksheet 

button' in general. We can instantly create a worksheet in our Excel workbook using this 

plus icon or button. Also, clicking this icon multiple times allows us to create multiple 

worksheets accordingly. 

 

As soon as we click the plus icon in the Sheet tab, a new worksheet is created to the 

right-most side of the last worksheet name. By default, the worksheet names are created 

in sequential order. For example, if we have three worksheets, such as Sheet1, Sheet2, 

and Sheet3, in our workbook and click the plus icon, the newly created worksheet will be 

named Sheet4. 
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Creating a worksheet using the Keyboard Shortcuts 

Excel has many built-in or predefined keyboard shortcuts that help quickly perform 

most tasks. We can also create a new worksheet within our Excel workbook using the 

keyboard shortcut. Excel has two different keyboard shortcuts to create a worksheet 

quickly without using the mouse. We can either use Shift + F11 or Alt + Shift + F1. 

However, we may need to use the Fn function key for some keyboards to activate 

function keys, such as F1, F2, … so on. 

 

To use the keyboard shortcut for creating a worksheet, we can perform the following 

steps: 

o First, we need to select any sheet from the Sheet tab. 

o Next, we need to press and hold the Shift key on the keyboard. 

o While holding the Shift key, we must press and release the F11 Lastly, we must 

release the Shift key. The new worksheet will be created quickly. 
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Activity 2 

Formulas and Functions in Excel 

Aim : To create an excel worksheet for student result analysis 

Procedure: 

Step 1: Open Ms office, Ms Excel – find new 

Step 2 : Select new columns and few rows at the centre of the worksheet – click format cells – 

select the element tab and click merge cell option – type heading 

Step 3  Enter the column heading – Enter the data in the following column like S.No, Reg.No,, 

Name ,MOB, ME etc., 

Step 4 : Enter the following formula to calculate 

Total = Sum (D5: G5) 

Percentage = (H5/6) 

Result – if(and (D5>35,E5>=35,F5>=35,G5>=35,H5>=35.I5=35),”Pass”, ”Fail”) 

Class = if (J5=”Pass”, if(I5>=75. ”Distinction”, if(I5>=60,”I class”, if(I5>=50,”Second Class”, if 

(J5>=35,”Pass”))),”Fail”) 

 

Step 5; After writing each formula select the cel and drag to the entire column to apply the 

formula 

Step 6 Save the work sheet by pressing Ctrl+S 

Step 7: Close Ms office by Alt +F4 
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IF 

In Excel, the IF formula is denoted as =IF(logical test, value if true, value if false). This lets 

you enter a text value into a cell “if” something else in your spreadsheet is true or false. 

Example: You may need to know which values in column A are greater than three. Using the 

=IF formula, you can quickly have Excel auto-populate a “yes” for each cell with a value 

greater than 3 and a “no” for each cell with a value less than 3. 

 

 

 

Excel nested IF statement 

Here's the classic Excel nested IF formula in a generic form: 

IF(condition1, result1, IF(condition2, result2, 

IF(condition3, result3, result4))) 

You can see that each subsequent IF function is embedded into 
the value_if_false argument of the previous function. Each IF function is enclosed in its 

own set of parentheses, but all the closing parentheses are at the end of the formula. 

Our generic nested IF formula evaluates 3 conditions, and returns 4 different results 
(result 4 is returned if none of the conditions is TRUE). Translated into a human 

language, this nested IF statement tells Excel to do the following: 
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Test condition1, if TRUE - return result1, if FALSE - 

test condition2, if TRUE - return result2, if FALSE - 

test condition3, if TRUE - return result3, if FALSE - 

return result4 
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Activity 3 

Create Save and use Macros 

 

Aim: To create , save and use macros in business application 

Procedure: 

Step 1: Open Ms Excel 2007 

Step 2: Select the File tab and press new  option to create a new book 

Step 3: Click on the ribbon choose customize option and add developers tab to the quick access 

menu 

Step 4: Create the following table 

Step 5: Start record macros from the developer tab 

Step 6 : Use formula to calculate basic salary, DA, HRA, Gross salary PDF, Professional tax, 

TDS, Total Deductions and net salary 

Step 7: Stop record macros from the developer tab 

Step 8: Save macros as Payroll 

Step 9 : Go to sheet 2 and type the salary statement table for the month of February . Enter 

names, CTC and ensure the table is in the same position as sheet 1 

Step 10:  Run Macros Payroll  and the salary calculation will be done automatically 

Step 11: Save the workbook as employee payroll by pressing Ctrl +S 
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Before you record a macro     

Macros and VBA tools can be found on the Developer tab, which is hidden by 

default, so the first step is to enable it. For more information, see Show the 

Developer tab. 

 

 

Record a macro     

1. In the Code group on the Developer tab, click Record Macro. 

2. Optionally, enter a name for the macro in the Macro name box, enter a 

shortcut key in the Shortcut key box, and a description in 

the Description box, and then click OK to start recording. 

 

3. Perform the actions you want to automate, such as entering boilerplate text 

or filling down a column of data. 

4. On the Developer tab, click Stop Recording. 

 

 

https://support.microsoft.com/en-us/office/show-the-developer-tab-e1192344-5e56-4d45-931b-e5fd9bea2d45
https://support.microsoft.com/en-us/office/show-the-developer-tab-e1192344-5e56-4d45-931b-e5fd9bea2d45
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Activity 4: 

Sorting and Querying Data By using Auto filter in Ms Excel 

Aim : To create a report of employee salary details containing the pair details of employee, that 

should be sorted and arranged according to the chronological order by using auto filter and sort. 

Procedure  

Step 1: Open Ms Office – Ms Excel _File – New worksheet 

Step 2:Select few columns and few rows at the center, Right click, format cell- Click alignment 

tab – Click merge cell options – ok – type the heading 

Step 3: Enter the column headings, Enter the data like serial number, name of employee, 

Employee Id, Basic Salary, DA, HRA, CCA, Gross, Net salary 

Step 4: Enter the following formula to calculate respective value 

DA 50% of Basics 

HRA 60%  

CCA 100 % 

DA is D5 *.5Gross  salary = Sum ( D5+E5+F5) 

Net Salary = Sum (D5+E5+F5+G5) 

Step 5: After finalizing the formula for every column, select the cell and drag the entire column 

to apply 

Step 6: Use auto filter for employee name in order to sort and query the data 

Step 7: After solving the summary of employee salary details will be finalized 

Step 8 : Save the worksheet by Ctrl +S. Close the worksheet by Alt+F4 
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How to sort in Excel? 

 

Select the data to sort     

Select a range of tabular data, such as A1:L5 (multiple rows and columns) or 

C1:C80 (a single column). The range can include the first row of headings that 

identify each column. 

 
  

 

Sort quickly and easily     

1. Select a single cell in the column you want to sort. 

2. On the Data tab, in the Sort & Filter group, click  to perform an 

ascending sort (from A to Z, or smallest number to largest). 

 

3. Click  to perform a descending sort (from Z to A, or largest number to 

smallest). 

 

Sort by specifying criteria     

Use this technique to choose the column you want to sort, together with other 

criteria such as font or cell colors. 
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1. Select a single cell anywhere in the range that you want to sort. 

2. On the Data tab, in the Sort & Filter group, click Sort to display the Sort 

popup window. 

 

  

 

3. In the Sort by dropdown list, select the first column on which you want to 

sort. 

4. In the Sort On list, choose Values, Cell Color, Font Color, or Cell Icon. 

5. In the Order list, choose the order that you want to apply to the sort 

operation—alphabetically or numerically, ascending or descending (that is, 

from A to Z (or Z to A) for text, or lower to higher, or higher to lower for 

numbers). 
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Activity 5: 

Calculation of Ratios using Excel 

Aim: To calculate ratios by preparing profit and loss account and Balance sheet in Excel 

Procedure :  

Step 1: Open Ms Office- Ms Excel 

Step 2: Select the file tab and click new options to a new book 

Step 3: Create the tile profit and loss, trading a/c and balance sheet 

Step 4: Prepare profit and loss a/c, trading a/c and balance sheet 

Step 5: Calculate current ratio by using the formula 

Current Ratio = Current asstesCurrent liabilities 

Step 6: Calculate the net profit ratio bby 

Net profit ratio = Net profit Sale *100 

Step 7 : Calculate working capital turnover ratio b y using the formula 

Working capital turnover ratio = Sales/Working capital 

Working capital = Current assets – Current liabilities 

Step 8: Save the document by using Ctrl +S by giving the name ratio 
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Using Excel to Calculate Financial Ratios - A Step-by-Step Guide 

Excel is one of the most commonly used financial analysis tools, and it's relatively easy to 

use even for those who aren't experts in finance. Here's a step-by-step guide to help you 

calculate financial ratios in Excel: 

1. First, input the financial data into the Excel sheet, for example, financial statements 

like a balance sheet, income statement, or cash flow statement. 

2. Identify the different ratios you'd like to calculate based on the financial data you've 

inputted. 

3. Create a separate table where you can input the formulas to calculate ratios. You 

should have one table for each category of ratios, e.g., profit margins, liquidity 

ratios, etc. 

4. Input the formula into each cell of the ratio table, referencing the data you inputted 

in the financial statement table. 

5. Once you've inputted the formulas, Excel will calculate the ratios for you, and you 

can interpret the ratios to make informed decisions about the organization. 

It's important to note that financial ratios should not be analyzed in isolation. Instead, they 

should be compared to industry benchmarks or historical trends to provide context and 

meaning. Additionally, it's crucial to understand the limitations of financial ratios and to 

use them in conjunction with other financial analysis tools to gain a comprehensive 

understanding of an organization's financial health. 

Common Accounting Terms Used in Financial Ratio Calculation 

Before diving into calculating financial ratios, it's essential to understand some common 

accounting terms that you'll come across in financial statements. These include revenue, 

cost of goods sold, gross profit, operating expenses, net profit, assets, liabilities, and equity, 

to name a few. Understanding what these terms mean is the foundation for calculating 

financial ratios accurately. 

One important term to understand is depreciation. Depreciation is the decrease in value of 

an asset over time due to wear and tear, obsolescence, or other factors. It is important to 

consider depreciation when calculating financial ratios, as it can impact the value of assets 

and the overall financial health of a company. Another term to be aware of is accruals, 

which are expenses that have been incurred but not yet paid. Accruals can affect financial 

ratios, such as the current ratio, which measures a company's ability to pay its short-term 

debts. 
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The Power of Ratio Analysis for Business Planning and Decision Making 

Ratio analysis is a powerful tool that allows businesses to make more informed decisions, 

whether it is to increase revenue, reduce costs, or analyze investments. Ratio analysis 

provides valuable insights into the organization's performance and can be used to develop 

business strategies and goals. Businesses can also use ratio analysis to compare their 

performance to similar companies in the industry and benchmark themselves against the 

competition. 

One of the key benefits of ratio analysis is that it can help businesses identify areas where 

they need to improve. For example, if a company's current ratio is lower than the industry 

average, it may indicate that the company is struggling to meet its short-term obligations. 

By identifying this issue, the company can take steps to improve its liquidity and financial 

health. 

Another advantage of ratio analysis is that it can help businesses identify trends over time. 

By comparing ratios from different periods, businesses can see how their performance has 

changed and identify areas where they have made progress or need to improve. This 

information can be used to make more informed decisions about future investments and 

business strategies. 
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Activity 6 : 

Sales Transaction using Ms Excel 

Aim: To prepare sales transaction report by using Ms Excel 

Procedure: 

Step 1: Open Ms Office – Ms Excel in a new tab 

Step 2: Prepare sales transaction report of a company (Amazon, Netflix) 

Step 3: Prepare a sales transaction of the company for the year ended December 2022 

Step 4: The transaction of the company begins from January to December 2022 

Step 5: Develop a report that includes Date, Client, Item No, Item Code, Item name Quantity 

cost, Tax rate , Taxes total 

Step 6 : Prepare raph for the below items that is date, client , item name, total cost. 

Step 7 : Use the formula for tax rate that is  

H7*15100 

Step 8 : Calculate tax by using the formula 

H7/I7 

Step 9 : Calculate total cost by the formula 

Total cost = Quantity * Cost 

Step 10 : Propose a graph by choosing the graph and chart option in home menu 

Step 11: Seelct pie chart Bar chart Column chart as per the requirement 

Step 12: Copy the chart in the Ms excel in window 

Step 13: Save the worksheet Ctrl +S 

Step 14: Close the document b Alt + F4 
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 Sales Report. 

 

 

  Get Product Name from Product List 

 In order to make a sales report let’s take some data like a list of 

products containing product Code, Product Name, and Unit Price. 
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 Now we will calculate daily sales. For that, we took a dataset like the 

following from which we will calculate product Name, Unit Price, 

and Total Sales of the day. 
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Activity 7: 

Monthly expenses report by Using Ms. Excel 

Aim : To prepare monthly expenses report by using Ms Excel 

Procedure: 

Step 1: Open Ms Excel blank worksheet 

Step 2: Setup monthly income expenses by merging two or three cells 

Step 3: Consider the column as below 

Step 4: Category due date, Actual income, Planned, Actual differences total 

Step 5: The category include monthly expenses due date which includes the payment need to be 

paid 

Step 6 : Calculate the difference column by using formula 

G7-H7 

Planned-Actual 

Total = Actual salary – Differences 

Step 7 : Use the charts from the home menu and include category total 

Step 8 : Save the document by using Ctrl +S 
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STEP 1: Prepare Excel Workbook 

 First, open a blank Excel workbook. 

 Then, give a clear heading of what this file is about. 

 After that, type the Month names. 

 See the below image for a better understanding. 

 Save the file. 

 

 

STEP 2: Set up Income Section 

 Now, input the income sources. 

 Here, we will place the Salary We’ll consider a fixed monthly salary in 

this example. 

 You can input any other sources of income. 

 

 

STEP 3: Insert Excel SUM Function to Compute Annual Income 

 Next, we’ll insert the SUM function to total the Salary. 

https://www.exceldemy.com/excel-sum-function/
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 For that purpose, select cell O6. 

 Type the formula: 
=SUM(C6:N6) 

 Subsequently, press Enter. 

 It’ll return the sum of the 12 months’ income. 

 

 
SPONSORED CONTENT  

STEP 4: Make Monthly Expenses Segment 

This step is the most important for us. So, pay attention. 

 Firstly, create a header for different types of Expenses. 

 The following picture will make it clear. 

 

 Consequently, input the precise Expense amounts. 
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 You need to type the amounts in the proper categories and months. 

 Otherwise, it will result in errors. 

 

 

STEP 5: Create Excel Formula to Automate Expenses Sheet 

Moreover, we wish to make our Expenses Sheet a dynamic one. 

Dynamic means, it’ll update automatically once a change happens in 

any of the expense values. Hence, follow the below process. 

 First of all, choose cell O9. 

 Then, type the below formula: 
=SUM(C9:N9) 

 Press Enter. 

 Thus, you’ll get the annual Rent fee. 
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 Afterward, use the AutoFill tool to get the annual total of other 

expenses. 
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 Now, we’ll figure out the month-wise expenses total. 

 For this reason, in cell C17, type the formula: 
=SUM(C9:C16) 

 Return the result by pressing Enter. 

 

 Next, apply AutoFill to complete the series. 

 

 At last, we’ll calculate the yearly total expenses. 
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 So, select cell O17. 

 Type the formula: 
=SUM(C17:N17) 

 Accordingly, press Enter. 

 Thus, you’ll get the sum of all the expenses in a year. 

 

 

STEP 6: Calculate Net Balance 

In our final step, we will determine the net balance. You just need to 

subtract the annual total expenses from the annual income. 

 Select cell I19 at first. 

 Then, type the following formula: 
=O6-O17 
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 Subsequently, press Enter. 

 In this way, you can get a surplus amount. 

 You can also see if there’s any due left to pay. 

 

 

Final Output of Monthly Expenses Sheet 

Finally, our Monthly Expenses Sheet is complete. You can modify any 

headers you want. You can type your own expense values there. It’ll 

automatically update and give you the correct results. The following 

picture demonstrates our designed expense tracker. 
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Activity 8 : 

Calculation of  Ratios by Using Excel 

Aim: To create formula for financial solutions and calculate current ratios 

Procedure; 

Step 1: Open Ms office – Ms Excel 

Step 2: Select the file tab and press new option to open a book 

Step 3: Create a table for current ratio with title 

 

Table showing current ratio 

Year Current Assets Current Liability Current Ratio 

2017-2018 200000 100000  

2018-2019 250000 150000  

2019-2020 275000 180000  

2021-2022 260000 190000  

2022-2023 300000 200000  

 

Step 4: Create a bar chart with years on x-axis and ratio on y-ais and given the tile of chart as 

Chart showing current ratio 

Step 5: Type the interpretation below the chart and mention the decision taken by compay 

regarding ratio 

Step 6 : Save the document by using Ctrl +S as ratio 

Step 7: Close the document by usine Alt+F4 
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TIPS TO PICK RIGHT FINANCIAL CHARTS  

 

1 Tip #1: Always pick the right chart type 

2 Tip #2: Remove unnecessary axes 

3 Tip #3: Distribute bars evenly 

4 Tip #4: Remove background lines 

5 Tip #5: Remove unnecessary styling 

6 Tip #6: Never use 3D effects 

7 Tip #7: Clean your financial chart 

8 Tip #8: Always remain consistent  

  

https://www.upslide.net/en/ways-to-make-beautiful-financial-charts-and-graphs-in-excel/#Tip_1_Always_pick_the_right_chart_type
https://www.upslide.net/en/ways-to-make-beautiful-financial-charts-and-graphs-in-excel/#Tip_2_Remove_unnecessary_axes
https://www.upslide.net/en/ways-to-make-beautiful-financial-charts-and-graphs-in-excel/#Tip_3_Distribute_bars_evenly
https://www.upslide.net/en/ways-to-make-beautiful-financial-charts-and-graphs-in-excel/#Tip_4_Remove_background_lines
https://www.upslide.net/en/ways-to-make-beautiful-financial-charts-and-graphs-in-excel/#Tip_5_Remove_unnecessary_styling
https://www.upslide.net/en/ways-to-make-beautiful-financial-charts-and-graphs-in-excel/#Tip_6_Never_use_3D_effects
https://www.upslide.net/en/ways-to-make-beautiful-financial-charts-and-graphs-in-excel/#Tip_7_Clean_your_financial_chart
https://www.upslide.net/en/ways-to-make-beautiful-financial-charts-and-graphs-in-excel/#Tip_8_Always_remain_consistent
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Activity 9 : 

Calculation of Sum, Average, count, Count A, Minimum, Maximum 

Aim : To do the calculation of Sum, Average,Count, Count A, maximum, minimum of Shipping 

Ltd ABC 

Procedure ; 

Step 1; Open Ms office- Ms Excel – New worksheet 

Step 2: Keep the heading as Shipping Limited ABC and merge the cell. Drag the data number of 

passenger in various port from the month January to June 

Step 3: Add the relevant data of umber of passenger from the month January to june, Calculate 

Sum from the month January to June with help of formula 

= Sum (D2:D12) 

Step 4: To calculate average, select the appropriate cells from January to June by using the 

formula 

- Average (D2: D12) 

Step 5:  Calculate count, drag the number of cells from January to June 

= Count (D2:D12) 

Step 6 : Calculate Count A, drag the cells and rows , columns to get the number of cells that has 

values that is by using the formula 

= Count A (D2:D12) 

Step 7: Calculate mazimum go for the function bar, a dialogue box will appear and set the option 

as maximum and insert the formula from January to June that is D2: D12. Hence the mazimum 

can be obtain from selection provided 

Step 8 : Calculate minimum  Go for the function option, a dialogue gox will appear and select 

the option as minimum and click okay. Then insert the following formula by dragging by 

January to June that D2: D12. The minimum value will be provided 

Step 9 : Select insert menur – choose graph option, draw that data range from sum to minimum 

from H2: H12 
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Excel Basic Formulas: Sum 
The Sum formula is a great one to start with.  Excel formulas all start with an = sign, followed by the 
function name and a section in parentheses to provide ranges or arguments.  Start out by typing 
=sum( 

 
Sum requires a range of cells you want to add together.  You can type your range in, or you can 
select it using your mouse or input device.  In this case, we will select D2:D21. 

 
Next up you can close the parenthesis, although newer versions of Excel will auto close it for you. 

 
Excel Basic Formulas: Sum, Average, Min, Max, and 
Count 
Using the same method, you can calculate the average, minimum value, maximum value, and count: 

https://efficientanalyst.com/excel-basic-formulas-sum-average-count-max-min/efficient-analyst-excel-basic-functions-sum-1/
https://efficientanalyst.com/excel-basic-formulas-sum-average-count-max-min/efficient-analyst-excel-basic-functions-sum-2/
https://efficientanalyst.com/excel-basic-formulas-sum-average-count-max-min/efficient-analyst-excel-basic-functions-sum-3/
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Which if you were using the downloadable exercise workbook, will give you the following results: 

 
Here are some basic formulas, and what they do. 

Sum Adds all the cells together and gives you the total sum. 

Average Gives you the average of the selection you provide. 

Min Returns the smallest value from the selection you provide. 

Max Returns the largest value from the selection you provide. 

Count Counts how many cells have values in them. 

 

 

 

 

 

 

 

 

 

 

https://efficientanalyst.com/excel-basic-formulas-sum-average-count-max-min/efficient-analyst-excel-basic-functions-sum-average-min-max-count/
https://efficientanalyst.com/excel-basic-formulas-sum-average-count-max-min/efficient-analyst-excel-basic-functions-sum-average-min-max-count-results/
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Activity 10: 

Application of Date Function in Order Processing 

Aim : To create tables  containing dates and use date function in order processing 

Procedure 

Step 1: Open Ms. Office – Ms.Excel  

Step 2: Select File Tab and press new option to open a new work book 

Step 3: Create the table title “Purchase/Order Status” with the columns Item No, Date, Day, 

Month, Yer, e-day, e-month, text 

Step 4: Use today function to return the date  

=Today ()-/+ day 

Step 5: Use Now function to return the time of recording the date 

= Now(Cell No) 

Step 6: Use day function to return the day 

=day(Cell no) 

Step 7: Use month function to return the month 

= month (Cell no) 

Step 8: Use the year function to return the year 

= year(Cell no) 

Step 9: Use E- month to return in Series 

=E-month (Cell No) 

Step 10 : Use E-date to return in data series 

=E-date (Cell No) 

Step 11: Save Text to return of month 

=Text (Reference cell , “Open Code dd,mm,yy”) 
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Step 12: Save the file “Order processing” 

The order processing data of ABC Ltd., as on today is given below 

 

Purchased item 01 before 20days for Rs.10000 

Purchased item 02  before 14 daysfor  Rs.5000 

Purchased item 01 before 3 days 

Purchased item 03 before 9 days 

Order placed for item 02 will be received after 2 days 

Order placed for item 03 will be received after 4 days 

Use date function to perfectly present the date. 
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Date Functions 
This table lists some of the date and time functions available in Excel. 

Function 

Name Function What the Function Does 

Date =DATE(year, month, day) 
Enters a date in the cell. Example: 

DATE(2019,5,1) equals May 1, 2019. 

Today =TODAY( ) 

A special version of the DATE 

function. The DATE function returns 

the value of any date; the TODAY 

function returns the value of the 

current date. 

Time 
=TIME(hour, minute, 

second) 

Enters a time in the cell. Uses a 24-

hour (military) time system. 

Example: TIME(14,30,0) equals 2:30 

PM. 

Now =NOW( ) 

A special version of the TIME function. 

The TIME function returns the value of 

any time; the NOW function returns 

the value of the current time. 

Year 
=YEAR(serial_number, 

return_type) 

Returns a value of the year for a 

specific date. The serial_number 

argument is a date value (or reference 

to one). 

Example: YEAR("3/15/2019") equals 

2019. 
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Function 

Name Function What the Function Does 

Month 
=MONTH(serial_number, 

return_type) 

Returns a value of the month for a 

specific date. The serial_number 

argument is a date value (or reference 

to one). 

Example: MONTH("3/15/2019") 

equals 3. 

Day 
=DAY(serial_number, 

return_type) 

Returns a value of the day for a 

specific date. The serial_number 

argument is a date value (or reference 

to one). Example: DAY("3/15/2019") 

equals 15. 

TODAY() Function 
If you need to calculate values based on dates, a very helpful function is TODAY, 

which returns today’s date. 

1. Select the cell where you want to add the TODAY() function. 

2. Click the Formulas tab on the ribbon. 

3. Click the Date & Time button. 

 



SREENIVASA INSTITUTE of TECHNOLOGY AND MANAGEMENT STUDIES 

(Autonomous) 

CHITTOOR-517 127 

DEPARTMENT OF MANAGEMENT STUDIES 

DATA ANALYTICS USING ADVANCED EXCEL LAB MANUAL 
 

4. Select Today. 

5. Click OK. 

 

You can also insert the function by typing =TODAY() in the cell. 

Excel adds today’s date. 

Date Calculations in Formulas 
Referencing cells with a date calculation in a formula is often no different than 

referencing cells with numbers—you can include date values in basic formulas. 

1. Select the cell where you want to calculate a date formula. 
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2. Press = and enter the formula, referencing the cells that contain a date 

formula. 

3. Click the Enter button. 
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Activity 11: 

Calculation of Sum, Sumif, Sumifs, Count, Countifs by Using Excel 

Aim: To prepare a car showroom details by calculating Sum, Sumif, Sumifs, Count, Countifs by 

using Ms Excel 

Procedure: 

Step 1: Open  Ms Office – Ms Excel  

Step 2: Prepare car show room details wit car type, car color, Price 

Step 3:  Fill the details of different types of car colors, price of the car 

Step 4: Calculate the total no.of cars by using Count option 

=Count (B2:B32) 

Total no.of cars is obtained 

Count if: 

Countif accepts one range and one criteria 

=Countif (range,”Red”) 

=Countif (Cartype, “Blue”) 

i.e countif(B2:B32,”Blue”) 

Countifs: 

It accepts multiple criteria 

Countifs = Countif(range, Cartype”,range”,”Cacolor”,range,”Car price”) 

=Countifs(range,”Kia”,range,”Blue”,range,”>3L”) 

=countifs(B2:B32.”Kia”,C2:C32,”Blue”,D2:D32,”>3L”) 

Sum : 

Sum(D2:D32) 
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Sumif: 

Sumif accepts  one criteria 

=Sumif(range,”Criteria”) 

Sumif(D2:D32,”>4L”) 

Sumifs: 

It calculates more than one criteria 

-Sumifs(range, “Red”,range,”Type”) 

=Sumifs(Carprice,carcolors, “Red”,Cartype,”Kia”) 

=Sumifs(D2:D32,C2:C32,”Red”,B2:B32,”Kia”) 

Step 5 : Save the worksheet by pressing  Ctrl+S 

Step 6: Close the worksheet by Alt +F4 
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The SUMIF and COUNTIF functions allow you to conditionally sum or count cells based 
on a single condition, and are compatible with almost all versions of Excel: 

=SUMIF(criteria_range, criteria, sum_range) 

=COUNTIF(criteria_range, criteria) 

The SUMIFS and COUNTIFS functions allow you to use multiple criteria, but are only 

available beginning with Excel 2007: 

=SUMIFS(sum_range, criteria_range1, criteria1, criteria_range2, 

criteria2,...) 

=COUNTIFS(criteria_range1, criteria1, criteria_range2, 

criteria2,...) 

AVERAGEIF and AVERAGEIFS are also part of this family of functions and have the 

same syntax as SUMIF and SUMIFS. 
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Activity No: 12 

Extracting data using combined V Lookup and H Look up 

Aim: To identify a specific data in excel worksheet 

Procedure: 

Step 1:Opem Ms Excel 2007 

Step 2: Select File Tab . Press new option to create a new book 

Step 3: Type the following table  

 GOLD SILVER COPPER 

COLUMN 2 3 4 

EUROPE 10 15 2 

ASIA 6 17 5 

AFRICA 18 3 30 

 

Step 4: For identifying how many coppeter medal with the continent Asia obtained, extract the 

data using the formula 

=VLookup(G3:b4:E6,Hlookup(H3B2:E3,2,False),False) 

G2=Continent 

He-=Medal 

J2=No.of medals 

Step 5: The output of extracted data will be shown 

Step 6: Save the workbook by pressing Ctrl+S by name data Extraction 
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VLOOKUP and HLOOKUP are functions in Excel that allow you to search a 
table of data and based on what the user has supplied and give appropriate 
information from that table. 

If you have a table of Student ID numbers, Student Names and Grades, you 
can set up Excel so that if a Student ID number is supplied by the user, it will 
look through the table and output the student's name and grade. 

 

 

VLOOKUP allows you to search a table that is set up vertically. That is, all of 
the data is set up in columns and each column is responsible for one kind of 
data. In the Student Record example, there would be a separate column of 
data for Student Names, one for Student ID numbers, etc. 

HLOOKUP is the exact same function, but looks up data that has been 
formatted by rows instead of columns. 
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The format of the VLOOKUP function is: 
VLOOKUP(lookup_value,table_array,col_index_num,range_lookup). 

The lookup_value is the user input. This is the value that the function uses to 
search on. If you are searching a table by the Student ID number, then the 
lookup_value is the cell that contains the inputted Student ID number being 
looked up. 

The table_array is the area of cells in which the table is located. This includes 
not only the column being searched on, but the data columns for which you 
are going to get the values that you need. Back to the example, the 
table_array would not only include the Student ID number column, but the 
columns for the Student Names and Grades as well. 

The col_index_num is the column of data that contains the answer that you 
want. If your table is set up as: column 1 - Student ID Number, column 2 - 
Student Names, column 3 - Grades and you inputted a Student ID Number 
and you want to retrieve the grade that was received for that person, the 
col_index_num would be 3. 3 is the column number of the data column for the 
ANSWER that you are trying to look up. 

Range_lookup is a TRUE or FALSE value. When set to TRUE, the lookup 
function gives the closest match to the lookup_value without going over the 
lookup_value. When set to FALSE, an exact match must be found to the 
lookup_value or the function will return #N/A. Note, this requires that the 
column containing the lookup_value be formatted in ascending order. 

To use the Function Wizard to insert a VLOOKUP function: 

1. Select the cell that will contain the answer to the VLOOKUP and access 
the Insert Function dialog, which depends upon the version of Excel that 
you are using: 

o For Excel 2007 and 2010: Go to the Formula tab on the ribbon, 
and choose Insert Function. 

o For Excel 2003 and earlier: Select Insert -> Function... 
2. Under the Function Category, choose either All or Lookup & 

Reference. 
3. Under the Function Name, select VLOOKUP, and hit OK. 
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4. The Function Wizard for VLOOKUP will then display. The 4 values 
talked about above (lookup_value, table_array, col_index_num, 
range_lookup) are required by the function. Each line for each value 
required. If you put the cursor into the first line for lookup_value, down 
below it explains what the lookup_value is for your reference. Similar 
information is displayed when the cursor is in any of the other fields. 

 

5. Enter in the lookup_value either by typing in the number for the cell, or, 
by selecting the cell on the worksheet. 

6. Enter in the table_array by typing in the numbers for the cells, or, by 
selecting the group of cells on the worksheet. 

7. Enter in the number for column which contains the data that you wish to 
obtain in the col_index_num area. 

8. Enter into the range_lookup field the value TRUE if the function should 
accept the closest value to your lookup_value without going over or 
FALSE if an exact match is required. 

9. Hit OK when ready. 
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Activity 13 

Consumer Satisfaction survey by using google form 

Aim: Creating a consumer satisfaction survey 

Procedure 

Step 1: Open G-mail account 

Step 2: Click on google apps icen in the gamila page 

Step 3: Click on google forms 

Step 5: Give the title “Consumer Satisfaction Survey” 

Step 6: Create the form that consist of following details 

a)Name 

b)Age 

C)Gender 

d) Educational qualification 

e)Indicate your level of satisfaction towards the mobile phone that you are using 

Highly satisfied 

Satisfied 

Neutral 

Dissatisfied 

Highly Dissatisfied 

f)I have the best mobile phone 

Strongly Agree 

Agree 

Neutral 
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Disagree 

Strongly Disagree 

g) The price of the mobile that I own is 

High 

Medium 

Low 

h)Mobile Brand __________________ 

Step 7: Choose the type of questions 

Step 8: Save the form 

Step 9: Send the form to respondents through a link 

Step 10: Consolidate the survey results 

 

 

 

 

 

 

 

 

 

 

 

 



SREENIVASA INSTITUTE of TECHNOLOGY AND MANAGEMENT STUDIES 

(Autonomous) 

CHITTOOR-517 127 

DEPARTMENT OF MANAGEMENT STUDIES 

DATA ANALYTICS USING ADVANCED EXCEL LAB MANUAL 
 
 

Create a survey 

Creating a new survey is simple: 

1. Visit https://surveys.google.com/your-surveys. 
2. Click + NEW SURVEY. 
3. In step 1 (Write questions), select the appropriate question type(s) and write your 

question(s). Click CONFIRM. 
4. In step 2 (Pick audience), name your survey and select your target audience. 

Click CONTINUE. 
5. In step 3 (Confirm survey), review your survey questions and purchase responses. You 

also have the option here to adjust the survey frequency. Click BUY NOW or START TEST* 
if your survey has screening questions. 

6. Your survey is sent to our team for review and you receive a confirmation email once it has 
been started. 

7. You receive another email with a link to your results once your survey is completed. 

https://surveys.google.com/your-surveys
https://support.google.com/surveys/answer/6215436

	What is a Worksheet in Excel?
	How to create/ insert a worksheet in Excel?
	Creating a worksheet using the Sheet tab
	Creating a worksheet using the Keyboard Shortcuts
	IF

	Excel nested IF statement
	How to sort in Excel?
	Using Excel to Calculate Financial Ratios - A Step-by-Step Guide
	Common Accounting Terms Used in Financial Ratio Calculation
	The Power of Ratio Analysis for Business Planning and Decision Making
	Get Product Name from Product List
	STEP 1: Prepare Excel Workbook
	STEP 2: Set up Income Section
	STEP 3: Insert Excel SUM Function to Compute Annual Income
	STEP 4: Make Monthly Expenses Segment
	STEP 5: Create Excel Formula to Automate Expenses Sheet
	STEP 6: Calculate Net Balance
	Final Output of Monthly Expenses Sheet

	Excel Basic Formulas: Sum
	Excel Basic Formulas: Sum, Average, Min, Max, and Count
	Date Functions
	TODAY() Function
	Date Calculations in Formulas
	To use the Function Wizard to insert a VLOOKUP function:


	Create a survey

